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Facility Location Data Guidance Note V1/07 

ABOUT THESE GUIDANCE NOTES 
 
 
These guidance notes have been prepared to assist applicants in the preparation 
of an application for an Integrated Pollution Prevention and Control (IPPC) Licence 
and Waste Licence. While every effort has been made to ensure the accuracy of 
the material contained in this document, the EPA assumes no responsibility and 
gives no guarantees, undertakings and warranties concerning the accuracy, 
completeness or up-to-date nature of the information provided herein and does 
not accept any liability whatsoever arising from any errors or omissions. 
 
Should there be any contradiction between the information requirements set out 
in the Application Form and any content contained in this Guidance Note, then the 
requirements in the Application Form should take precedence.  
 
For queries of an administrative or technical nature in relation to submitting 
digital drawing files and tabular data templates please contact: 
 

Mr. Gavin Smith 
Environmental Protection Agency 

Johnstown Castle Estate 
Co. Wexford 

 
Telephone: 053-9160600 
E-mail: g.smith@epa.ie 
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1. INTRODUCTION 
 
During the licence application process applicants are required to submit drawings 
of the proposed installation/facility including information on the site boundary and 
infrastructure as well as the proposed emission, monitoring and sampling points. 
In addition to submitting the drawings in paper format with the application, 
applicants are required to submit digital drawings files electronically on a separate 
CD included with the application. The information should be supplied to the EPA in 
an electronic format and geo-referenced within the Irish National Grid system. 
The EPA incorporates these drawings within the EPA’s geographical information 
management systems (GIS) to facilitate the licensing process. This document 
provides detailed guidance on the information required and the procedures for 
preparing data for submission with the licence application. 
 
2. OVERVIEW OF DATA REQUIRED 
 
Applicants are required to submit geo-referenced digital drawing files (e.g. 
AutoCad files) with the application, showing the following in Irish Grid projection: 
 
• Site boundary and overall site plan under Section B.2 of the application. 

• Emission points proposed under Section E.6 of the application. 

• Monitoring and sampling points under Section F.3 of the application. 
 
Acceptable drawing file formats include DXF, DWG, DGN, ESRI Shapefile, MapInfo 
or other upon agreement with the EPA. This data should be submitted to the EPA 
on a separate CD-Rom. 
 
In addition to the drawing files applicants are required to submit tabular data 
templates outlining the following information: 
 
• The proposed atmospheric, surface water, sewer, ground and noise emission 

points as outlined in sections E.1 to E.5 of the application. The template will 
include information on the emission point code, emission type, Irish Grid 
reference (6E, 6N) and state if verified with a GPS. 

• The proposed emissions monitoring and sampling points as outlined in section 
F.2 of the application. The template will include information on the 
monitoring/sampling point code, the point type, Irish Grid references (6E, 6N) 
and state if verified with a GPS. 

 
The data for the above sections should be entered into separate tabular data 
templates and submitted to the EPA on the CD containing the digital drawing files 
outlined above. Tabular data templates can be downloaded from the Licensing 
pages of the EPA website at www.epa.ie. 
 
 
3. PREPARATION OF DIGITAL DRAWING FILES 
 
The preparation and submission of detailed site plans outlining the site boundary, 
site infrastructure, on-site and off-site emission points, and the site monitoring 
and sampling points are a requirement of the application process. The EPA 
requires applicant to submit these site plans in a digital format (DXF, DWG, DGN, 
ESRI Shapefile, or MapInfo) and projected within the Irish Grid projection system. 
The production of such site plans is most commonly carried out in AutoCAD. This 
section outlines the method for projecting AutoCAD files such as DXF, DWG and 
DGN formats in Irish Grid projection. 
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The Irish Grid as mentioned above is the primary projection system used in 
Ireland and by the EPA. Point locations are represented by 6 digit Eastings and 
Northings.  For example 315986, 234395 is the Irish Grid Reference for the 
centre point of O’Connell Bridge in Dublin. Further technical details on the Irish 
Grid coordinate system are available from the Ordnance Survey of Ireland 
website at www.osi.ie. The Irish Grid is the projection system required for all 
digital drawing files and point locations being submitted to the EPA as part of the 
application process. 
 
Confirming a Drawing Files Projection: 
 
To confirm whether or not a drawing has already been projected in Irish Grid the 
drawing can be checked in AutoCAD using the following steps. 
  

1. Open the file in AutoCAD. 

2. In the lower left corner of the AutoCAD window, the co-ordinates of the 
drawing can be viewed.  If the co-ordinates are not visible, right click on 
the corner to turn them on (Fig. 1). 

 

 
 

Fig.1: Location of Drawing Co-ordinates in the bottom left corner 
 

3. If the co-ordinates are large number of digits, similar to the known grid 
references it is probable that the drawing has already been projected in 
Irish Grid.  This should be verified against known reference points. If 
drawings are projected in Irish Grid they are ready for submission. 

4. If the co-ordinates are similar to the format -7.46, 53.20, it is likely that 
the drawing has been projected using decimal degrees. Drawings 
projected using decimal degrees should be re-projected in Irish Grid. 

5. Drawings that are not projected will have co-ordinates near 0,0,0 when 
the cursor is moved towards the bottom left hand corner of the window.  
Such maps have been drawn using 0,0,0 as the base point and will need to 
be projected into the Irish Grid as outlined in the next section of this 
document. 

 
Projecting a Drawing File in Irish Grid: 
 
If it has been confirmed that the drawing file has not already been projected into 
the Irish Grid, the file can be projected using the following steps.   
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Before converting the drawing file   

1. Ensure that the correct Irish Grid reference of at least one easily 
identifiable point in the drawing is known.  For example the most northerly 
emission point or the bottom left corner of the main building. 

 
2. In AutoCAD set the drawing units to metres:  

− Go to the Format menu, 
− Select Units (Fig.2),  
− In the Drawing Units dialog box that opens, choose metres as the 

Insertion Scale and click OK (Fig.3).   
 

 
 

Fig.2: Format Menu, Select Units 
 
 

 
 

Fig.3: Drawing Units Window – Drawing units should be set to metres 
 
 

3. Open the .dwg file within AutoCAD 
− Go to the File menu, 
− Select Open, a new window should open to browse to the required 

drawing file. 
 

4. For ease of viewing, zoom to the extent of the drawing 
− Right click mouse, choose Zoom (Fig.4), 
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− Right click mouse again, choose Zoom Extents (Fig.5), 
− Hit escape (Esc) on the keyboard. 

 
 

 
Fig.4: Right Click – Zoom 
 
 

 
 
 
 

 
Fig.5: Right Click 
 

5. Ensure that the Object Snapping option in turned on  
− Go to the Tools menu, 
− Select Drafting Settings (Fig.6).   
− In the Drafting Settings dialog box, go to the Object Snap tab and 

select Object Snap On.  In the Object Snap Modes, ensure that at 
least endpoint, centre, node and intersection are turned on. Then 
click OK (Fig.7). 

 

   
 

 Fig.6: Tools menu, Drafting Settings       Fig.7 Drafting Settings – ensure Object 
Snap is turned on  
 
 

6. Check the current co-ordinates of the drawing.  The co-ordinates of the 
drawing can be viewed in the very bottom left corner of the AutoCAD 
window (see section on “Confirming a Drawing Files Projection”).  If the 
drawing is not already geo-referenced, when the mouse cursor is moved 
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towards the lower left hand corner of the screen, the co-ordinates should 
be 0,0,0 or close to that.   

 
 Geo-Referencing the Drawing File (Fig.8) 

7. To move the scaled site drawing from its current co-ordinates to new Irish 
Grid co-ordinates carry out the following steps: 

− In the Command line 
    Type MOVE and hit the return key. 

− The user will be requested to SELECT OBJECTS 
   Type ALL 
    Hit return, users may have to hit return twice. 

− The user will then be asked to SPECIFY BASE POINT OR 
[DISPLACEMENT] 
 Using the mouse click onto the known base point on the 

screen. The base point is a point for which exact 6E 6N Irish 
Grid references are known.  Ensure that the cursor snaps to 
exactly the right point. 

 

 
 

 Fig.8: Command lines for moving the drawing 
 
 

8. The user will then be asked to SPECIFY SECOND POINT, at this point 
type in the correct Irish Grid Co-ordinate in the Command line and hit 
return.  If the drawing disappears from the screen zoom to the extent of 
the drawing by right clicking the mouse and choose zoom, then right 
clicking again and choose Zoom Extents.  

9. The drawing should now be accurately geo-referenced.  You can check this 
by moving the mouse over the point for which you have set the co-
ordinates.  In the lower left hand corner of the screen the new co-
ordinates of the drawing should be visible and should have changed from 
0,0,0 to coordinates similar to those just entered. 

10. The same process should be carried out for all drawings that are being 
submitted to the EPA as part of the application process.  

 

4. PREPARATION OF TABULAR DATA TEMPLATES 
 
The preparation and submission of 6E 6N Irish Grid references for all emission, 
monitoring and sampling points is a requirement of sections E and F of the 
application form. The EPA also require applicants to submit this data on emission, 
monitoring and sampling points in a digital format on tabular data templates (e.g. 
in excel or .dbf files or similar on agreement). Tabular data templates are 
available on the Licensing pages of the EPA website at www.epa.ie. This section 
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outlines the format of the tabular data templates and the type of information 
required within the templates. 
 
Tabular Data Template for Emission Points 

Applicants are required to list all proposed atmospheric, surface water, sewer, 
ground and noise emission points as outlined in sections E.1 to E.5 of the 
application. The template should be structured in the same way as the templates 
outlined in Fig.9 and Fig.10. One row should be assigned to each emission point 
with the correct information for each field. 
 
 

PT_CD PT_TYPE EASTING NORTHING VERIFIED 
Provide 
label ID’s 
assigned in 
Section E of 
application 

A = Atmospheric 
SW = Surface 
Water 
SE = Sewer 
GW = Groundwater 
N = Noise 
SL = Soil / Ground 
WS = Waste 

6E-digit 
GPS Irish 
National 
Grid 
Reference 

6N-digit 
GPS Irish 
National 
Grid 
Reference 

Y = GPS 
used 
N = GPS 
not used 

 
Fig.9: Structure of tabular data template for emission points 
 
 

PT_CD PT_TYPE EASTING NORTHING VERIFIED 
A1-1 A 302255 116995 Y 
SW1 SW 302018 116745 Y 
SW2 SW 302232 116437 Y 
SE1 SE 302253 116896 Y 
GW1 GW 302368 117257 Y 
N1 N 302384 117030 Y 
N2 N 302324 117053 Y 

 
Fig.10: Sample emission point data (sample data not real emission points) 
 
 
Tabular Data Template for Monitoring and Sampling Points 

Applicants are required to list all proposed emissions monitoring and sampling 
points as outlined in section F.3 of the Application Form. The template should be 
structured in the same way as the templates outlined in Fig.11 and Fig.12. One 
row should be assigned to each emissions monitoring and sampling point with the 
correct information for each field. 
 
 

PT_CD PT_TYPE EASTING NORTHING VERIFIED 
Provide 
label ID’s 
assigned in 
Section F3 
of 
application 

M = Monitoring 
S = Sampling 

6E-digit 
GPS Irish 
National 
Grid 
Reference 

6N-digit 
GPS Irish 
National 
Grid 
Reference 

Y = GPS 
used 
N = GPS 
not used 

 
 
Fig.11: Structure of tabular data template for emissions monitoring and sampling points 
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PT_CD PT_TYPE EASTING NORTHING VERIFIED 
A1-1 M 302255 116995 Y 
SW1 M 302018 116745 Y 
SW2 M 302232 116437 Y 
SE1 M 302253 116896 Y 
GW1 M 302368 117257 Y 
N1 M 302384 117030 Y 
N2 M 302324 117053 Y 

 
Fig.12: Sample emissions monitoring and sampling point data (sample data not real 
emission points) 
 
 
SUBMITTING DIGITAL DRAWING FILES AND TABULAR DATA TEMPLATES 
 
All digital drawing files and tabular data templates should be submitted on a 
separate CD and delivered with the application to the EPA. The CD should contain 
the following data: 
 

1. Digital drawing file of site boundary and overall site plan projected in Irish 
Grid. 

2. Digital drawing file of all proposed emission points projected in Irish Grid. 
3. Digital drawing file of all proposed emissions monitoring and sampling 

points projected in Irish Grid. 
4. Digital tabular data template for proposed emission points including 6E 6N 

Irish Grid references for each point. 
5. Digital tabular data template for proposed emissions monitoring and 

sampling points including 6E 6N Irish Grid references for each point. 
 
It is recommended that the data be stored on the CD using the folder structure 
outlined in Fig.13. 
 

 
 
Fig.13: Recommended folder structure for storing required data on CD 
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